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An Examp l e—H-Bend Wavegu i d e

Introduction

This examples shows how to model a rectangular waveguide for microwaves. A single 
hollow waveguide can conduct two kinds of electromagnetic waves: transversal 
magnetic (TM) or transversal electric (TE) waves. This model examines a TE wave, 
one that has no electric field component in the direction of propagation. More 
specifically, for this model you select the frequency and waveguide dimension so that 
TE10 is the single propagating mode. In that mode the electric field has only one 
nonzero component—a sinusoidal with two nodes, one at each of the walls of the 
waveguide.

One important design aspect is how to shape a waveguide to go around a corner 
without incurring unnecessary losses in signal power. Unlike in wires, these losses 
usually do not result from ohmic resistance but instead arise from unwanted 
reflections. You can minimize these reflections by keeping the bend smooth with a 
large enough radius. In the range of operation the transmission characteristics (the 
ability of the waveguide to transmit the signal) must be reasonably uniform for 
avoiding signal distortions.

Model Definition

This example illustrates how to create a model that computes the electromagnetic 
fields and transmission characteristics of a 90° bend for a given radius. This type of 
waveguide bends changes the direction of the H field components and leaves the 
direction of the E field unchanged. The waveguide is therefore called an H-bend. The 
H-bend design used in this example is well-proven in real-world applications and you 
can buy similar waveguide bends online from a number of manufacturers. This 
particular bend performs optimally in the ideal case of perfectly conducting walls as is 
shown later on in this model by computing the (in this case optimal) transmission 
characteristics.

The waveguide walls are typically plated with a very good conductor, such as silver. In 
this example the walls are considered to be made of a perfect conductor, implying that 
n × E = 0 on the boundaries. This boundary condition is referred to as a perfect 
electric conductor (PEC) boundary condition.
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The geometry is as follows, as viewed in the xy-plane.

D O M A I N  E Q U A T I O N S

The waveguide is considered to continue indefinitely before and after the bend. This 
means that the input wave needs to have the form of a wave that has been traveling 
through a straight waveguide. The shape of such a wave is determined by the boundary 
conditions of Maxwell’s equations on the sides of the metallic boundaries, that is, the 
PEC boundary condition. If polarized according to a TE10 mode, the shape is known 
analytically to be E = (0, 0, sin(π (a − y)/(2 a))) cos(ωt) given that the entrance 
boundary is centered around the y = 0 axis, and that the width of the waveguide, in 
the y direction, is 2a.

In the RF Module you can model this waveguide in the 2D In-Plane TE Waves 
application mode or in the 3D Electromagnetic Waves application mode as a 
time-harmonic wave propagation model. This means that only the phasor component 
of the field is modeled. The incident field then has the form 
E = (0, 0, E0z) = (0, 0, sin(π (a − y)/(2 a))), and is considered as part of the expression 
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, where complex-valued 
arithmetic has been used (also referred to as the jω method).

The width of the waveguide is chosen so that it has a cutoff frequency of 4.3 GHz. 
This makes the waveguide operational between 5.4 GHz up to 8.1 GHz. At higher 
frequencies other modes than the TE10 appear, causing a “dirty” signal. The input 
wave then splits into several modes that are hard to control without having large power 
losses. Below the cutoff frequency, no waves can propagate through the waveguide. 
This is an intrinsic property of microwave waveguides.

The cutoff frequency of different modes in a straight waveguide is given by the relation

where m and n are the mode numbers (m = 1, n = 0 for the TE10 mode), a and b are 
the lengths of the sides of the waveguide cross-section, and c is the speed of light.

For this waveguide, a = 2b and b = 0.0174245.

The first few cutoff frequencies are (νc)10 = 4.3 GHz, (νc)01 = 8.6 GHz, 
(νc)11 = 9.6 GHz and the operational range is chosen to be 1.25(νc)10 = 5.4 GHz to 
0.95(νc)10 = 8.1 GHz. This is to have reasonable margins for manufacturing errors 
and to avoid the large reflections that occur at lower frequencies.
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B O U N D A R Y  C O N D I T I O N S

This model makes use of the predefined port boundary condition. It is an automated 
version of the matched boundary condition described later in this section. An 
additional advantage is that the port boundary condition automatically creates 
postprocessing variables for the S-parameters. 

The input matched boundary condition consists of two parts: an incident planar wave 
and an absorbing boundary condition. The matched boundary condition is also used 
at the output boundaries to eliminate any reflections there. At the output boundaries 
there is no excitation. The walls of the waveguide are considered to be good 
conductors, so you can use the perfectly electric conductive (PEC) boundary 
condition.

For specifying the absorbing boundary condition you must know the propagation 
constant, β, of the wave. You can find the propagation constant from an eigenmode 
analysis of the waveguide cross section.

In this simple case, however, you can also compute the propagation constant by hand 
using the relation

for the wavenumbers in the x,  y, and z directions, respectively, at the waveguide 
entrance port. Here x is the direction of propagation, and y and z are the transversal 
directions, with z as the out-of-plane direction. In an infinitely extended straight 
waveguide, the following equations define the free-space and the x, y, and z direction 
wavelengths:

In this case, the y direction wavelength is known to be 2a because the model describes 
the lowest propagating mode, which is a half wavelength across the transversal 
direction. This means for the wave number in the y direction
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Also, for the TE10 mode, 

The free-space wave number is

The propagation constant evaluates to

,

which is a frequency-dependent expression.

Now, for the matched boundary condition, entering the correct propagation constant 
eliminates all waves with that wavenumber in the propagating direction. To make the 
boundary condition perfectly absorbing, the propagating direction needs to be the 
same as the normal direction of the output boundary.

Note: The input amplitude can be replaced by any analytical expression. You can, for 
instance, create a wave corresponding to a truncated Gaussian beam or simply a 
planar wave, for which the expression would be 1.

The first part of the analysis is made for a frequency that is 20% above the cutoff 
frequency. This is to show a generic propagating wave within the frequency range of 
operation.
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Results and Discussion

The wave is found to propagate through the bend with very small reflection.

To verify that there is almost no reflection you can compare the power flow of the 
outgoing wave to that of the incoming wave. The entrance port is excited using the 
port boundary condition, which automatically normalizes the excitation to unit power 
(1 W). Comparing this to the power flow over the output port, 1.006 W, shows that 
the power loss is less than 1%.

For the 2D version of the model the power flow is 0.99993 W, indicating that any 
reflected power is too small to be detected. The 2D model is more accurate than the 
3D model because it uses a finer mesh that better resolves the waves.

Model Library path: RF_Module/RF_and_Microwave_Engineering/
waveguide_hbend_3d
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reflections. You can minimize these reflections by keeping the bend smooth with a 
large enough radius. In the range of operation the transmission characteristics (the 
ability of the waveguide to transmit the signal) must be reasonably uniform for 
avoiding signal distortions.

Model Definition

This example illustrates how to create a model that computes the electromagnetic 
fields and transmission characteristics of a 90° bend for a given radius. This type of 
waveguide bends changes the direction of the H field components and leaves the 
direction of the E field unchanged. The waveguide is therefore called an H-bend. The 
H-bend design used in this example is well-proven in real-world applications and you 
can buy similar waveguide bends online from a number of manufacturers. This 
particular bend performs optimally in the ideal case of perfectly conducting walls as is 
shown later on in this model by computing the (in this case optimal) transmission 
characteristics.

The waveguide walls are typically plated with a very good conductor, such as silver. In 
this example the walls are considered to be made of a perfect conductor, implying that 
n × E = 0 on the boundaries. This boundary condition is referred to as a perfect 
electric conductor (PEC) boundary condition.
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The geometry is as follows, as viewed in the xy-plane.

D O M A I N  E Q U A T I O N S

The waveguide is considered to continue indefinitely before and after the bend. This 
means that the input wave needs to have the form of a wave that has been traveling 
through a straight waveguide. The shape of such a wave is determined by the boundary 
conditions of Maxwell’s equations on the sides of the metallic boundaries, that is, the 
PEC boundary condition. If polarized according to a TE10 mode, the shape is known 
analytically to be E = (0, 0, sin(π (a − y)/(2 a))) cos(ωt) given that the entrance 
boundary is centered around the y = 0 axis, and that the width of the waveguide, in 
the y direction, is 2a.

In the RF Module you can model this waveguide in the 2D In-Plane TE Waves 
application mode or in the 3D Electromagnetic Waves application mode as a 
time-harmonic wave propagation model. This means that only the phasor component 
of the field is modeled. The incident field then has the form 
E = (0, 0, E0z) = (0, 0, sin(π (a − y)/(2 a))), and is considered as part of the expression 
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, where complex-valued 
arithmetic has been used (also referred to as the jω method).

The width of the waveguide is chosen so that it has a cutoff frequency of 4.3 GHz. 
This makes the waveguide operational between 5.4 GHz up to 8.1 GHz. At higher 
frequencies other modes than the TE10 appear, causing a “dirty” signal. The input 
wave then splits into several modes that are hard to control without having large power 
losses. Below the cutoff frequency, no waves can propagate through the waveguide. 
This is an intrinsic property of microwave waveguides.

The cutoff frequency of different modes in a straight waveguide is given by the relation

where m and n are the mode numbers (m = 1, n = 0 for the TE10 mode), a and b are 
the lengths of the sides of the waveguide cross-section, and c is the speed of light.

For this waveguide, a = 2b and b = 0.0174245.

The first few cutoff frequencies are (νc)10 = 4.3 GHz, (νc)01 = 8.6 GHz, 
(νc)11 = 9.6 GHz and the operational range is chosen to be 1.25(νc)10 = 5.4 GHz to 
0.95(νc)10 = 8.1 GHz. This is to have reasonable margins for manufacturing errors 
and to avoid the large reflections that occur at lower frequencies.
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B O U N D A R Y  C O N D I T I O N S

This model makes use of the predefined port boundary condition. It is an automated 
version of the matched boundary condition described later in this section. An 
additional advantage is that the port boundary condition automatically creates 
postprocessing variables for the S-parameters. 

The input matched boundary condition consists of two parts: an incident planar wave 
and an absorbing boundary condition. The matched boundary condition is also used 
at the output boundaries to eliminate any reflections there. At the output boundaries 
there is no excitation. The walls of the waveguide are considered to be good 
conductors, so you can use the perfectly electric conductive (PEC) boundary 
condition.

For specifying the absorbing boundary condition you must know the propagation 
constant, β, of the wave. You can find the propagation constant from an eigenmode 
analysis of the waveguide cross section.

In this simple case, however, you can also compute the propagation constant by hand 
using the relation

for the wavenumbers in the x,  y, and z directions, respectively, at the waveguide 
entrance port. Here x is the direction of propagation, and y and z are the transversal 
directions, with z as the out-of-plane direction. In an infinitely extended straight 
waveguide, the following equations define the free-space and the x, y, and z direction 
wavelengths:

In this case, the y direction wavelength is known to be 2a because the model describes 
the lowest propagating mode, which is a half wavelength across the transversal 
direction. This means for the wave number in the y direction
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Also, for the TE10 mode, 

The free-space wave number is

The propagation constant evaluates to

,

which is a frequency-dependent expression.

Now, for the matched boundary condition, entering the correct propagation constant 
eliminates all waves with that wavenumber in the propagating direction. To make the 
boundary condition perfectly absorbing, the propagating direction needs to be the 
same as the normal direction of the output boundary.

Note: The input amplitude can be replaced by any analytical expression. You can, for 
instance, create a wave corresponding to a truncated Gaussian beam or simply a 
planar wave, for which the expression would be 1.

The first part of the analysis is made for a frequency that is 20% above the cutoff 
frequency. This is to show a generic propagating wave within the frequency range of 
operation.
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Results and Discussion

The wave is found to propagate through the bend with very small reflection.

To verify that there is almost no reflection you can compare the power flow of the 
outgoing wave to that of the incoming wave. The entrance port is excited using the 
port boundary condition, which automatically normalizes the excitation to unit power 
(1 W). Comparing this to the power flow over the output port, 1.006 W, shows that 
the power loss is less than 1%.

For the 2D version of the model the power flow is 0.99993 W, indicating that any 
reflected power is too small to be detected. The 2D model is more accurate than the 
3D model because it uses a finer mesh that better resolves the waves.

Model Library path: RF_Module/RF_and_Microwave_Engineering/
waveguide_hbend_3d
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The geometry is as follows, as viewed in the xy-plane.
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boundary is centered around the y = 0 axis, and that the width of the waveguide, in 
the y direction, is 2a.

In the RF Module you can model this waveguide in the 2D In-Plane TE Waves 
application mode or in the 3D Electromagnetic Waves application mode as a 
time-harmonic wave propagation model. This means that only the phasor component 
of the field is modeled. The incident field then has the form 
E = (0, 0, E0z) = (0, 0, sin(π (a − y)/(2 a))), and is considered as part of the expression 
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, where complex-valued 
arithmetic has been used (also referred to as the jω method).

The width of the waveguide is chosen so that it has a cutoff frequency of 4.3 GHz. 
This makes the waveguide operational between 5.4 GHz up to 8.1 GHz. At higher 
frequencies other modes than the TE10 appear, causing a “dirty” signal. The input 
wave then splits into several modes that are hard to control without having large power 
losses. Below the cutoff frequency, no waves can propagate through the waveguide. 
This is an intrinsic property of microwave waveguides.

The cutoff frequency of different modes in a straight waveguide is given by the relation

where m and n are the mode numbers (m = 1, n = 0 for the TE10 mode), a and b are 
the lengths of the sides of the waveguide cross-section, and c is the speed of light.

For this waveguide, a = 2b and b = 0.0174245.

The first few cutoff frequencies are (νc)10 = 4.3 GHz, (νc)01 = 8.6 GHz, 
(νc)11 = 9.6 GHz and the operational range is chosen to be 1.25(νc)10 = 5.4 GHz to 
0.95(νc)10 = 8.1 GHz. This is to have reasonable margins for manufacturing errors 
and to avoid the large reflections that occur at lower frequencies.
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B O U N D A R Y  C O N D I T I O N S

This model makes use of the predefined port boundary condition. It is an automated 
version of the matched boundary condition described later in this section. An 
additional advantage is that the port boundary condition automatically creates 
postprocessing variables for the S-parameters. 

The input matched boundary condition consists of two parts: an incident planar wave 
and an absorbing boundary condition. The matched boundary condition is also used 
at the output boundaries to eliminate any reflections there. At the output boundaries 
there is no excitation. The walls of the waveguide are considered to be good 
conductors, so you can use the perfectly electric conductive (PEC) boundary 
condition.

For specifying the absorbing boundary condition you must know the propagation 
constant, β, of the wave. You can find the propagation constant from an eigenmode 
analysis of the waveguide cross section.

In this simple case, however, you can also compute the propagation constant by hand 
using the relation

for the wavenumbers in the x,  y, and z directions, respectively, at the waveguide 
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Also, for the TE10 mode, 

The free-space wave number is

The propagation constant evaluates to

,

which is a frequency-dependent expression.

Now, for the matched boundary condition, entering the correct propagation constant 
eliminates all waves with that wavenumber in the propagating direction. To make the 
boundary condition perfectly absorbing, the propagating direction needs to be the 
same as the normal direction of the output boundary.

Note: The input amplitude can be replaced by any analytical expression. You can, for 
instance, create a wave corresponding to a truncated Gaussian beam or simply a 
planar wave, for which the expression would be 1.

The first part of the analysis is made for a frequency that is 20% above the cutoff 
frequency. This is to show a generic propagating wave within the frequency range of 
operation.
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3D Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator, select 3D in the Space dimension list.

2 In the list of application modes, select RF Module>Electromagnetic Waves>Harmonic 

propagation.

3 Click OK.

O P T I O N S  A N D  S E T T I N G S

1 From the Options menu, choose Constants.

2 Define the following constants in the Constants dialog box (the descriptions are 
optional); when done, click OK.

G E O M E T R Y  M O D E L I N G

1 From the Draw menu, open the Work-Plane Settings dialog box. Click OK to obtain 
the default work plane in the xy-plane.

2 From the Options menu, choose Axes/Grid Settings.

NAME EXPRESSION DESCRIPTION

fc 4.3e9 Cutoff frequency

fq1 1.2*fc 20% above cutoff
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3 In the Axes/Grid Settings dialog box, specify the following settings; when done, click 
OK.

To define the grid spacings, first click the Grid tab and clear the Auto check box.

The waveguide width 2*0.0174245 corresponds to a cutoff frequency of 4.3 GHz.

4 Start by drawing three lines. After selecting the Line button on the Draw toolbar, 
click at (0, −0.0174), (−0.1, −0.0174), (−0.1, +0.0174), and (0, +0.0174).

5 Click the 2nd Degree Bézier Curve button, and click at (0.0576, 0.0174) and 
(0.0576, 0.075). 

6 Click the Line button, and click at (0.0576, 0.175), (0.0924, 0.175), and 
(0.0924, 0.075). 

7 Click the 2nd Degree Bézier Curve button, and click at (0.0924, −0.0174). 

8 Finish by clicking the right mouse button to close the boundary curve and create a 
solid object.

AXIS GRID

x min -0.175 x spacing 0.05

x max 0.175 Extra x 0.075-0.0174245 0.075+0.0174245

y min -0.04 y spacing 0.05

y max 0.2 Extra y -0.0174245 0.0174245 0.075 0.175
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9 Select Extrude from the Draw menu. Extrude the object using a distance of 0.0174.

10 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S  S E T T I N G S

Scalar Variables
1 From the Physics menu, choose Scalar Variables.

2 In the Application Scalar Variables dialog box, set the frequency nu_rfw to fq1, and 
then click OK.

Boundary Conditions
1 From the Physics menu, choose Boundary Settings.

2 Select Boundaries 2–8 and 10.

3 In the Boundary condition list, select Perfect electric conductor as the boundary 
condition. These boundaries represent the inside of the walls of the waveguide 
which is plated with a metal, such as silver, and considered to be a perfect conductor.
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4 On Boundaries 1 and 9, specify the Port boundary condition. On the Port page, set 
the values according to the following table; when done, click OK.

Subdomain Settings
Use the default values for εr, µr, and σ, because the waveguide is filled with air.

M E S H  G E N E R A T I O N

1 In the Free Mesh Parameters dialog box, click the Custom mesh size button, and then 
type 0.006 in the Maximum element size edit field.

SETTINGS BOUNDARY 1 BOUNDARY 9

Port number 1 2

Wave excitation at this port Selected Cleared

Mode specification Rectangular Rectangular

Mode type Transverse electric (TE) Transverse electric (TE)

Mode number 10 10
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2 Click Remesh to generate the mesh; then click OK.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar to solve the problem.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot is a slice plot of the total energy density. This is a convenient way to 
visualize the good transmission, because reflections give rise to a wave pattern in the 
energy distribution. To better see the propagating wave change the position of the 
slices.

1 From the Postprocessing menu, choose Plot Parameters.

2 On the Slice page in the Plot Parameters dialog box, set the Slice positioning x levels 
to 0, y levels to 0, and z levels to 1.
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3 Click Apply to see the following plot.

To better see the propagating wave, plot the electric field’s z-component.

4 From the Predefined quantities list, select Electric field, z-component.
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5 From the Color table list choose WaveLight, then click OK.

6 To compare the power flow of the incident wave to the power flow of the outgoing 
wave, perform a boundary integration. The entrance port is excited using the port 
boundary condition, which provides an excitation with a power level of 1 W. To 
obtain the power outflow from the exit port, open the Boundary Integration dialog 
box from the Postprocessing menu, and integrate Power outflow, time average over 
Boundary 9. The result is about 1.006 W and appears in the message log at the 
bottom of the main window.

Model Library path: RF_Module/RF_and_Microwave_Engineering/
waveguide_hbend_2d

2D Modeling Using the Graphical User Interface

The results obtained in the 3D calculation are independent of the height b of the 
waveguide as the TE10 wave does not vary in the z direction. This means that the 
model can just as well be made in 2D.
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You find an extended version of this model with an S-parameter study in the section 
“H-Bend Waveguide with S-parameters” on page 111 in the RF Module Model 
Library. See also the section “S-Parameters and Ports” on page 57 for more 
information about S-parameter calculations.

M O D E L  N A V I G A T O R

1 Select 2D from the Space dimension list.

2 Select the RF Module>In-Plane Waves>TE Waves>Harmonic propagation application 
mode.

3 Click OK.

O P T I O N S  A N D  S E T T I N G S

Define the same constants as in the 3D model on page 27.

G E O M E T R Y  M O D E L I N G

Use the same axes/grid settings and draw the same geometry as in the 2D work plane 
in the 3D model.

P H Y S I C S  S E T T I N G S

Scalar Variables
1 From the Physics menu, choose Scalar Variables.

2 In the Application Scalar Variables dialog box, set the frequency nu_rfwe to fq1, and 
then click OK.

Boundary Conditions
Use the same boundary conditions as in the 3D model:

1 On Boundaries 2–4 and 6–8, select the Perfect electric conductor boundary 
condition.

2 On Boundaries 1 and 5, specify the Port boundary condition. On the Port page set 
the values according to the table below:

SETTINGS BOUNDARY 1 BOUNDARY 5

Port number 1 2

Wave excitation at this port Selected Cleared

Mode specification Analytic Analytic

Mode number 1 1
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M E S H  G E N E R A T I O N

1 Initialize the mesh.

2 Refine the mesh twice.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the electric field’s z component. Qualitatively, the result 
coincides with the result in the 3D model. The difference in amplitude is because the 
input power in the 2D port boundary condition is 1 W per unit depth (1 m).

1 To plot the energy density, open the Plot Parameters dialog box.
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2 Click the Surface tab, and select Total energy density, time average from the 
Predefined quantities list on the Surface Data page. Click OK.

This again shows that the reflections are very small. To further verify this compare the 
power flow of the incoming wave to the outgoing wave. To compare the power flow 
of the incident wave to the power flow of the outgoing wave, perform a boundary 
integration. The entrance port is excited using the port boundary condition, which 
provides an excitation with a power level of 1 W (per unit depth). To obtain the power 
outflow from the exit port, open the Boundary Integration dialog box from the 
Postprocessing menu, and integrate Power outflow, time average over Boundary 5. The 
result, 0.99993 W, which appears in the message log, indicates that any reflected power 
is too small to be detected. Note that the 2D model is more accurate than the 3D 
model because it uses a finer mesh that better resolves the waves.


